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1 Reason for Change

Below are KPN consistency review comments on OMA-TS-BCAST_Services version  of 29-12-2206

OMA-TS-BCAST_Services-V1_0-20061229-D
	ID
	Open Date
	Editorial
	Section
	Description
	Status

	
	01-02-2007
	N
	5.3.6.1
	Source: KPN
Comment:

The InteractivityMedia document carries web-pages in a GZIP archive under the MediaObjectSet. However the most basic usecase would be just to provide a URL to an external web-page, which is not enabled right now.

Proposed solution

Include a web-URL as part of the InteractivityMediaDocument. See CR 2007-0145 (this CR) 
	Status: OPEN




2 Impact on Backward Compatibility

None
3 Impact on Other Specifications

None
4 Intellectual Property Rights

Members and their Affiliates (collectively, "Members") agree to use their reasonable endeavours to inform timely the Open Mobile Alliance of Essential IPR as they become aware that the Essential IPR is related to the prepared or published Specification.  This obligation does not imply an obligation on Members to conduct IPR searches.  This duty is contained in the Open Mobile Alliance application form to which each Member's attention is drawn.  Members shall submit to the General Manager of Operations of OMA the IPR Statement and the IPR Licensing Declaration.  These forms are available from OMA or online at the OMA website at www.openmobilealliance.org.

5 Recommendation

Accept the detailed change proposal as defined below.
6 Detailed Change Proposal

Change 1:  (optional)Brief description of specific change

5.7.5.2 Interactivity Media Document

The following table defines the message format of Interactivity Media Documents.
	Name
	T
y
p
e
	C
a
t
e
g
o
r
y
	C
a
r
d
i
n
a
l
i
t
y
	Description
	Data Type

	Interactivity MediaDocument
	E
	NO/TM
	1..N
	The InteractivityMedia document defines the actual InteractivityMedia objects 
Contains the following attributes:


groupID


groupPosition


id

version

validFrom

validTo

Contains the following sub-elements:


MediaObjectGroup



	

	groupID
	A
	NM/TM
	1
	ID of the group of Interactivity Media document, globally unique
	anyURI

	groupPosition
	A
	NM/TM
	1
	Relative position of this document in the group.
	unsignedInt

(16 bits)

	id
	A
	NM/TM
	1
	ID of the InteractivityMedia document, globally unique. 
	anyURI

	version
	A
	NM/TM
	1
	Version of this fragment. The newer version overrides the older one with the same id as soon as it has been received.
	unsignedInt

	validFrom
	A
	NM/TM
	0..1
	The first moment when the media object sets in this document SHALL be rendered. If not given, the media object sets SHALL be rendered as soon as they are available.
	unsignedInt expressed as NTP time

	validTo
	A
	NM/TM
	0..1
	The last moment when the media object set SHALL be rendered. If not given the rendering is assumed to end in undefined time in the future. 

Whenever there is an InteractivityMedia document available with the same GroupID but with a higher GroupPosition the terminal SHALL stop rendering the current document. 
	unsignedInt expressed as NTP time

	MediaObjectGroup
	E1
	NM/TM
	1..N
	Grouping of the media object sets, which serve the same purpose during interactivity, e.g. as a starting media object set, as a media object set to be shown after action was taken or to be shown after time-out was reached.

Has the following attributes:
            id
            startMediaFlag

Has the following sub-elements:
            ActionDescriptor

            BackOffTiming

            MediaObjectSet (generic structure)
            SMSTemplate (non-generic media object set)
            EmailTemplate (non-generic media object set)

            PhoneNumber

Weblink
            Alternative text

	

	id
	A
	NM/TM
	1
	The ID of the media group
	anyURI

	startMediaFlag
	A
	NM/TM
	1
	The flag indicates, whether the media object sets in this MediaObject Group should be started with.

There SHALL only be one MediaObjectGroup with this flag set to “true” in an Interactivity Media Document
	boolean

	Action Descriptor
	E2
	NM/TM
	0..1
	The action descriptor describes the behaviour of the terminal when the media objects enable end-user input.

Has the following attributes


inputAllowedTime

onTimeOutPointer

updateFlag

onActionPointer


	

	inputAllowedTime
	A
	NM/TM
	0..1
	The last moment the terminal allows the end-user to provide end-user input for the active media object set in this media object group.
	unsignedInt expressed as NTP time

	onTimeOutPointer
	A
	NM/TM
	0..1
	This pointer refers to the ID of a media object group in this interactivity media document. When the InputAllowedTime is passed the terminal SHALL present the appropriate media object set of the media object group indicated by this pointer.

The terminal SHALL NOT present this media object set if the terminal has already presented the media object set indicated by the OnActionPointer.
	anyURI

	updateFlag
	A
	NM/TM
	0..1
	Whenever this flag is “true” the terminal shall listen to and fetch the following interactivity media document and the associated media objects from the file delivery stream when the Inputallowedtime is passed. The following inter-activity media document is identified by the document with the same group ID and a higher GroupPosition number.
	boolean

	onActionPointer
	A
	NM/TM
	0..1
	This pointer refers to the ID of a media object group in this interactivity media document. When the end-user undertakes action before the InputAllowedTime, which triggers the terminal to send out a message over the interaction channel (e.g. MMS, SMS or HTTP request), the terminal SHALL present the appropriate media object set of the media object group indicated by this pointer. 

If this pointer refers to the same ID as the current media object group, the terminal SHALL return to the same media object set after completing the action. In this case InputallowedTime and OnTimeOutPointer SHALL NOT be declared.
	anyURI

	BackOffTiming
	E2
	NM/TM
	0..1
	This element specifies timing behaviour of interaction sent back from the device to the service provider. Its purpose is to provide a mechanisms that ensures distribution over time of feedback sent from receivers, e.g. in order to avoid overload in nodes or links. 

If present, the interaction, if any, SHALL be sent back in the time interval [OffsetTime, OffsetTime+RandomTime] after the event that triggered the interactivity (e.g. user feedback). The exact time within the allowed time window shall be random with uniform probability.

Explicit timing behaviour expressed in Interactivity Media Document prevails over possible default timing behaviour expressed in InteractivityData.
	

	offsetTime
	A
	NM/TM
	1
	The OffsetTime specifies the minimum time that a device SHALL wait after an event that triggers interaction (e.g. user input), before sending the interaction. The unit is seconds (fractions can be expressed using data type Decimal). OffsetTime shall be a non-negative number.
	Decimal 


	randomTime
	A
	NM/TM
	1
	The RandomTime refers to the time window length over which a device SHALL calculate a random time for the transmission of interaction. The method provides for statistically uniform distribution over a relevant period of time. 

The device SHALL calculate a uniformly distributed random time out of the interval between 0 and RandomTime. The unit is seconds (fractions can be expressed using data type Decimal). RandomTime shall be a non-negative number.
	Decimal

	MediaObjectSet
	E2
	NM/TM
	0..N
	A media object set is defines the media objects attached to one interactivity technology proposed in the MediaObjectGroup. These media objects are related to each other, and form an interactivity unit to be rendered upon MediaObjectGroup activation (provided this interactivity technology is the one selected for rendering).

The set of media objects is not stored in the MediaObjectGroup itself (i.e. in the InteractivityMedia document) but as another external file, where this external file is :

· either one uncompressed media file (like a .3GP video, a .JPEG picture).

· or one GZIP archive file containing one or several compressed media objects (a .GZ file e.g. containing a compressed SMIL + 3GP video + text)

The GZIP archive format is the one defined in [RFC1951] and [RFC1952]. In case the archive contains multiple media objects, it consists of the plain concatenation of each compressed media object (i.e. each GZIP member), as specified in section 2.2 of [RFC1952].

The optional FNAME field SHOULD be set by the sender in each GZIP member header, with an FNAME value in accordance with the <Object> Content-Location one (see below Content-Location description). 

The <MediaObjectSet> element contains the following attributes:

                relativePreference


Content-Type

                Content-URI

The language of a MediaObjectSet element is expressed by using the built-in XML attribute xml:lang with this element.

The <MediaObjectSet> element contains the following elements:


Description


File


Object
	

	relativePreference
	A
	NM/TM
	0..1
	This attribute gives the RelativePreference of this media object set.

If multiple media object sets are declared in the MediaObjectGroup, the BCAST application SHALL render the media object set with the highest relative preference among the media object sets it supports.
	unsignedInt

(32 bits)

	Content-Type
	A
	NM/TM
	1
	Gives the media type of the <MediaObjectSet>’s external file :

· If this media type is ‘application/x-gzip’, the external file is a GZIP archive file containing one or several media objects.

· Otherwise (in this version of the specification) the external file is one uncompressed media file (e.g. ‘video/3gpp’ for a 3GP video file containing a SMIL presentation).

In case the external file is transported by FLUTE, this attribute MUST match the <File> Content-Type value provided in the FDT instance(s) describing this file.
	string

	Content-URI
	A
	NM/TM
	1
	Uniquely identifies the <MediaObjectSet>’s external file within the file delivery session.

In case this external file is transported by FLUTE, this attribute MUST match the <File> Content-Location value provided by the FDT instance(s) describing this file.
	anyURI

	Description
	E3
	NM/TM
	0..N
	Description of the Media Object Set, possibly in multiple languages. This can be used to provide the end-user extra information regarding the Media Object Set content.

The language is expressed using built-in XML attribute xml:lang with this element. 
	string

	Object
	E3
	NM/TM
	0..N
	Describe each media object contained in the media object set.

Depending on <MediaObjectSet>’s external file nature:

· if a single uncompressed file, this element is not needed unless it can provide supplemental information not given by parent <MediaObjectSet> (such as <PartType>, etc.).

· if a GZIP archive, the sequence order of <Object>s in <MediaObjectSet> MUST be the same as the sequence of members in the GZIP archive (side-by-side relationship between <Object> sequence and GZIP members).

Contains the following attributes:

Content-Location

             Content-Type

start

Contains the following elements:

             PartType


	

	Content-Location
	A
	NM/TM
	0..1
	If <MediaObjectSet>’s external file is an uncompressed file: useless.

If <MediaObjectSet>’s external file is a GZIP archive: 

The external file can be found by decompressing the n-th member of the GZIP archive, given n is the position of the <Object> in the <MediaObjectSet>. 

The Content-Location value SHALL be a Relative-Path Reference as defined in [RFC3986] and SHALL represent the sub-folder(s) + the filename of the deflated GZIP member to be used on storage.

This relative storage content location is intended to be directly pointed by common markup language references (typically via src=”” and href””).

If present, the FNAME field of the GZIP member MAY be verified against the filename part of Content-Location, ignoring case differences. In case these two values differ, the terminal MAY choose to discard the Media Object Set.

When storing the deflated media object, the terminal MUST create any indicated sub-folder(s) specified in the Content-Location, and store the media object in the leaf sub-folder, using the file name indicated in the Content-Location.The terminal SHOULD preserve the letter case specified in the Content-Location value when deflating the subfolders and the media file locally. The dot-segment “.” MUST be supported.  

Content-Location value SHALL be unique within the sequence of <Object> elements belonging to the same <MediaObjectSet> in the following respect: A folder (including root folder) SHALL NOT contain two different subfolders or files for which the names only differ by the letter case.

For security reasons, the terminal SHOULD discard the Media Object Set in case a naming conflict is detected.

For security reasons, the terminal SHOULD discard the Media Object Set if one or several dot-segments “..” are present in the Content-Location.
	anyURI

	Content-Type
	A
	NM/TM
	1
	If <MediaObjectSet>’s external file is an uncompressed file: useless (information already given in <MediaObjectSet>).

If <MediaObjectSet>’s external file is a GZIP archive:
Gives the media type of the GZIP archive member mapped to the <Object>.
	string

	start
	A
	NM/TM
	1
	If <MediaObjectSet>’s external file is an uncompressed file, or else a GZIP archive containing one media object: useless (implictly “true”).

If <MediaObjectSet>’s external file is a GZIP archive containing multiple media objects :
This attribute must be set to “true” for exactly one <Object> and one only in the <Object> sequence, the “start media object” on which the interactivity client must be launched.  

Default value, and applicable value for the other <Object> elements : false
	boolean


	PartType
	E4
	NM/TM
	0..N
	Indicates the media types that should be supported also in order to correctly render an <Object> consisting of several sub-media objects.

E.g. a 3GP “Extended-presentation profile” would be one <Object> with one “application/smil” <PartType>  advertising the presence of a SMIL presentation in the file.
	string

	File
	E3
	NO/TM
	0..1
	Present in case ALC without FLUTE is used for the delivery of <MediaObjectSet>’s external file.

Structure identical to the <File> child element of <FileDescription> in Content fragment.

Editor’s note : do we need to duplicate this lengthy description ?
	

	SMSTemplate
	E2
	NM/TM
	0..N
	Contains the following attributes:

relativePreference

Contains the following elements:

Description

SelectChoice

Note: the SMSTemplate is a media object set, although not encoded using the <MediaObjectSet> generic structure.

Note: The SMS Template provides information about the option(s) in an interaction, but does not contain rendering information. If rendering is to be specified by the service provider, the interaction can alternatively be described in an XHTML document with in-lined SMS URIs.
	

	relativePreference
	A
	NM/TM
	0..1
	This attribute gives the RelativePreference of this media object set.

If multiple media object sets are declared in the MediaObjectGroup, the BCAST application SHALL render the media object set with the highest relative preference of the media object sets it supports.
	unsignedInt

(32 bits)

	Description
	E3
	NM/TM
	0..N
	Text describing the interaction to the end user, possibly in multiple languages. The language is expressed using the built-in XML attribute xml:lang with this element.

This text can e.g. describe the overall scope of the interaction, valid for all interaction options described below. It might e.g. also contain information about the prize of the SMS interaction.
	string

	text
	A
	NO/TM
	0..1
	This attribute can contain a string that can be inserted into SMS messages specified by SMS-URI attributes below.

Note: this attribute enables message size savings for the case where the same text appears in the SMS bodies of several choices, i.e. if multiple SelectChoice elements are present  
	string

	SelectChoice
	E3
	NM/TM
	0..N
	Contains the following attributes:

SMS-URI

Contains the following elements:

ChoiceText

Note: For an interaction with multiple choices (like a voting between several options), the SelectChoice elements describe the different options to the user, and declare the SMS interaction to be executed when the user selects this option. For an interaction with one choice (e.g. an offer to purchase merchandise like a ringtone), there is only one SelectChoice element. Rendering of the choice(s) to the user is out of scope of this specification.
	

	SMS-URI
	A
	NM/TM
	1
	SMS receiver address and payload encoded as “sms:” URI scheme.

Value of this attribute SHALL comply with “sms:” URI scheme [URI-Schemes], with the following exceptions:

If the sms-body [URI-Schemes] of the sms URI scheme contains the string “$userid$”, it shall be replaced by the user ID.

If the sms-body [URI-Schemes] of the sms URI scheme contains the string “$deviceid$”, it shall be replaced by the device ID.

If the sms-body [URI-Schemes] of the sms URI scheme contains the string “$userinput$”, it should be replaced by a string that the user can enter. This may be an empty string.

If the sms-body [URI-Schemes] of the sms URI scheme contains the string “$text$”, it SHALL be replaced by the string signalled in the attribute “Text” (if this attribute is present).
	anyURI

	ChoiceText
	E4
	NM/TM
	0..N
	Description of the inetraction option, possibly in multiple languages. This is used to provide the end-user information on this interaction choice..

The language is expressed using the built-in XML attribute xml:lang with this element. 
	string

	EmailTemplate
	E2
	NO/TM
	0..N
	Contains attributes:

relativePreference

toHeader

ccHeader

bccHeader

subjectHeader

Contains the following elements:

Description

             MessageBody

Note: the EmailTemplate is a media object set, although not encoded using the <MediaObjectSet> generic structure.
	

	relativePreference
	A
	NO/TM
	0..1
	This attribute gives the RelativePreference of this media object set.

If multiple media object sets are declared in the MediaObjectGroup, the BCAST application SHALL render the media object set with the highest relative preference of the media object sets it supports.
	unsignedInt

(32 bits)

	toHeader
	A
	NO/TM
	1
	The e-mail recipient(s) as defined in [RFC 2822]
	string

	ccHeader
	A
	NO/TM
	0..1
	The e-mail cc-recipient(s) as defined in [RFC 2822]
	string

	bccHeader
	A
	NO/TM
	0..1
	The e-mail bcc-recipient(s) as defined in [RFC 2822]
	string

	subjectHeader
	A
	NO/TM
	0..1
	The e-mail subject header as defined in [RFC 2822]
	string

	Description
	E3
	NO/TM
	0..N
	Description of the Email Template, possibly in multiple languages. This can be used to provide the end-user extra information regarding the Email message.

The language is expressed using the built-in XML attribute xml:lang with this element. 
	string

	MessageBody
	E3
	NO/TM
	0..1
	The e-mail message body (text format defined in [RFC 2822]

To instruct the XML parser to preserve the whitespace in the MessageBody, the builtin XML attribute “xml:space” with the fixed value”preserve” is attached to this element.

Note: At least one of  Subjectheader and MessageBody in an EmailTemplate SHOULD be present
	string

	PhoneNumber
	E2
	NO/TM
	0..N
	Phone number to which the terminal initiates a voice call when the interactivity related to this Interactive Media Document is triggered. The terminal SHALL prompt the user before actually making the call. 

A terminal with voice call capabilities MUST support telephone URI [RFC 3966]. Further, a terminal with SIP capabilities MUST support SIP URI [RFC 3261].
	anyURI

	Weblink
	E2
	NM/TM
	0..N
	This provides a reference to an external website.
Contains attributes:
- relativePreference

- webURL
Contains the following elements:

- Description
	

	relativePreference
	A
	NM/TM
	0..1
	This attribute gives the RelativePreference of this media object set.

If multiple media objects sets are declared in the MediaObjectGroup, the BCAST application SHALL render the media object set with the highest relative preference of the media object sets it supports.
	unsignedInt

(32 bits)

	webURL
	A
	NM/TM
	1
	URL to an external website.
	anyURI

	Description
	E3
	NM/TM
	0..1
	Description of the Weblink, possibly in multiple languages. This can be used to provide the end-user extra information regarding the Weblink.

The language is expressed using the built-in XML attribute xml:lang with this element.
	string

	AlternativeText
	E2
	NM/TM
	0..N
	Alternative Text to be displayed if none of the other media object sets is supported by the terminal

Possibly in multiple languages. The language is expressed using the built-in XML attribute xml:lang with this element.
	string

	PrivateExt 
	E1
	NO/TO
	0..1
	An element serving as a container for proprietary or application-specific extensions. 
	

	<proprietary elements>
	E2
	NO/TO
	0..N
	Any number of proprietary or application-specific elements that are not defined in this specification. These elements may further contain sub-elements or attributes.
	


Table N: TBD

The legend used in in this table: 

Type: E=Element, A=Attribute, E1=sub-element, E2=sub-element’s sub-element, E[n]=sub-element of element[n-1]

Category: NM = Mandatory for network to support; NO = Optional for network to support; TM = Mandatory for terminal to support; TO = Optional for terminal to support

Cardinality: i..j = the number of the presented instance of this element/attribute is in the range from i to j. If i=0, this specific element/attribute is Optional for network to use, otherwise it is Mandatory for network to use.













NO REPRESENTATIONS OR WARRANTIES (WHETHER EXPRESS OR IMPLIED) ARE MADE BY THE OPEN MOBILE ALLIANCE OR ANY OPEN MOBILE ALLIANCE MEMBER OR ITS AFFILIATES REGARDING ANY OF THE IPR’S REPRESENTED ON THE “OMA IPR DECLARATIONS” LIST, INCLUDING, BUT NOT LIMITED TO THE ACCURACY, COMPLETENESS, VALIDITY OR RELEVANCE OF THE INFORMATION OR WHETHER OR NOT SUCH RIGHTS ARE ESSENTIAL OR NON-ESSENTIAL.

THE OPEN MOBILE ALLIANCE IS NOT LIABLE FOR AND HEREBY DISCLAIMS ANY DIRECT, INDIRECT, PUNITIVE, SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES ARISING OUT OF OR IN CONNECTION WITH THE USE OF DOCUMENTS AND THE INFORMATION CONTAINED IN THE DOCUMENTS.

USE OF THIS DOCUMENT BY NON-OMA MEMBERS IS SUBJECT TO ALL OF THE TERMS AND CONDITIONS OF THE USE AGREEMENT (located at http://www.openmobilealliance.org/UseAgreement.html) AND IF YOU HAVE NOT AGREED TO THE TERMS OF THE USE AGREEMENT, YOU DO NOT HAVE THE RIGHT TO USE, COPY OR DISTRIBUTE THIS DOCUMENT.

THIS DOCUMENT IS PROVIDED ON AN "AS IS" "AS AVAILABLE" AND "WITH ALL FAULTS" BASIS.

© 2006 Open Mobile Alliance Ltd.  All Rights Reserved.
Page 1 (of 12)
Used with the permission of the Open Mobile Alliance Ltd. under the terms as stated in this document.
[OMA-Template-ChangeRequest-20060101-I]

© 2006 Open Mobile Alliance Ltd.  All Rights Reserved.
Page 12 (of 12)
Used with the permission of the Open Mobile Alliance Ltd. under the terms as stated in this document.
[OMA-Template-ChangeRequest-20060101-I]

